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Partner of MISSING.NET 

 

 

 

CONFIDENTIALITY CHARTER 
www.missing.net 

  

LEGAL NOTICE 

Pursuant to the dispositions of article 6 III 1° of the law n°2004-575 of June 21st 2004 for 
trust in the electronic economy, we inform you that: 

 The present website, accessible at the URL address www.missing.net (hereinafter 
the "Site") is published by the Fondation Casques Rouges, an interim association in 
activity in Paris in the form of an association as defined by the law of July 1st 1901, 
with legal domicile at 1 rue Descartes, 75005 Paris, France. 

 The Site’s Director of publication is: Nicole Guedj 
 The Site’s webhost is : Google App Pro Engine 

 

 
This Confidentiality Charter (the “Charter”) governs the collection, treatment and 
safeguarding of personal data on the Site www.missing.net. 
 
For the purposes of the present Charter, the “Casques Rouges”, “we” and “our” designate 
the Fondation Casques Rouges. 
 
For the purposes of the present Charter, the “member”, “you” and “your” designate the 
user of the Site and the services offered thereon. 
 
This Charter is intended to clarify what are personal data concerning both Users and 
missing persons following a natural, industrial, epidemiological, environmental or 
ecological disaster (the “Disaster”) which we collect, how we protect them and how we 
use them. 
 
Please read what follows before starting to use the Site. 
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Registration on the Site and access to services provided thereon (the “Services”) imply 
your full and unreserved acceptance of the terms of the present Charter as regularly 
updated. 
 
This Charter applies solely to data collected by the Site, notably at the time of your 
registration.  We are not responsible for the confidentiality of the information which you 
reveal or post on a public forum and which may be collected by sites which you can access 
via the Site or which gave you access to the Site, but which are exploited or held by third 
parties.  
 
The Casques Rouges encourage you to examine the privacy policies of these other web 
sites so that you can understand how they collect, use and share information concerning 
you. 
 
 
 
 

1. THE COLLECTING OF PERSONAL DATA  

 

Your personal details consist of information which concerns you and identifies you or 
makes it possible to identify you, for example your name, your e-mail address, your 
address or telephone number ("Personal data"). You can browse certain pages of the Site 
without registering as a member. In that case, we will not handle personal data concerning 
you, but we may use non-personal information as indicated below. 
 
In order to access the Site and services occasionally available on the Site, you must 
register on the Site and create an account in compliance with the applicable regulatory 
dispositions and with the Terms of Use. At the time of creation of your account you will be 
asked to provide the following information: 
 

 Surname 
 First name 
 Email adress 
 Date of birth 
 Email address 
 Organisation 
 Telephone number 
 Fax number 
 Address 
 City 
 Postal Zip 
 Country 

 
 
In order to complete your registration, we will need you to provide us with personal details 
which will include, among other things, your name, your address, your e-mail address and 
a password.  
 
We will use your Personal data in compliance with stipulations of this Confidentiality 
Charter 
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You can at any moment modify and update the information of your account by modifying 
your account settings or by sending an e-mail to the following address: 
contact@missing.net 

 

2. THE COLLECTING OF NON-PERSONAL INFORMATION  

 
In addition to personal data, we can collect and save the traces of details which by 
themselves cannot be used to identify or contact you, for example, demographic 
information (such as the age, profession or sex), domain names, your type of computer, 
the type of browser you use as well as other anonymous statistical data (“Non-Personal 
Information”). We use this Non-Personal Information in order to help us understand who 
our users are, and to improve and promote the Site in order to facilitate the search for 
missing persons following a Disaster. 
 
We can collect Non-Personal Information, even if you choose not to register on the Site. 
We collect this information by using tracking tools consisting of various Internet 
technologies, notably “cookies”, “tags” and “JavaScript” (jointly “Tracking tools”).  
 
These Tracking tools are files which are placed on your computer in order to identify your 
Web browser as well as your activity on the Site. These Tracking tools enable us to develop 
a profile of your preferences on the Site. In this way we can personalise and improve your 
visits to the Site.  
 
You have the possibility of refusing cookies using your browser settings. You can turn off 
cookies by using the appropriate function of your browsing software by setting your 
browser in the following manner: 
 

 For Mozilla Firefox: 
Choose the “tools” menu then “Options”  
Click on the “privacy” icon 
Find the “cookies” menu and select the options which suits you  
 

 For Microsoft Internet Explorer  6.0:  
Choose the “Tools” menu, then “Internet Options”   
Click on the “Confidentiality” tab,   
Select the desired level of the cursor.  
 

 For Microsoft Internet Explorer 5:  
Choose the “Tools” menu, then “Internet Options”.   
Click on the “Security” tab,   
Select “Internet” then “CustomLevel”, 
Find the “cookies” heading and choose the option which suits you.  
 

 For Opera 6.0 and later: 
Choose the “File” menu then “Preferences”  
Private life  
 
However, if cookies are turned off, you might not be able to benefit from all the Site’s 
functions. 
 
 

3. USE OF PERSONAL DETAILS 
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Your Personal details will be primarily used in pursuance of our activity, in order to use the 
Site’s Services and functions as well as for any question in reasonable connection with this 
usage.  

We may also use your Personal data for the following general purposes: for general 
communication with yourself, to reply to your questions and comments, to resolve claims, 
to prevent potentially forbidden or illegal activities, to inform you about our activities, to 
carry out the Terms of Use or for any other reason described in the paragraph concerning 
collecting. 

If you do not wish to receive e-mails or other mail from the Casques Rouges, you may 
simply indicate this by your account settings or in writing to the following address: 

 

Fondation Casques Rouges 

1 rue Descartes 

75005 PARIS 

contact@casques-rouges.org 

Lastly, we can use your Personal data in order to offer you additional services. 

By way of example, we may send you newsletters, with the aim of informing you of the 
latest Site news and Services which we offer to aid the search for missing persons. If you 
no longer wish to receive our newsletters, you can choose not to receive any more by 
sending an e-mail to the e-mail address given above. You can also follow the unsubscribe 
link found in every newsletter. 

Unless you give your express permission to do so, we do not share, sell, exchange or hire 
your Personal details. 

We reserve the right to use your Personal data in order to communicate with you on 
subjects relating to the state of your account, modifications of this Charter, or of any 
other Charter or agreements concerning the use of the Site. 

 

4. YOUR RIGHTS CONCERNING YOUR PERSONAL DATA  

 

All Personal details you communicate to us are strictly confidential.  
 
We want the Personal data which we keep concerning you to be as exact as possible. You 
can access your Personal data and update the information directly on the Site using your 
chosen login and password. 
 
In compliance with articles 39 and 40 of the law N°78-17 of January 6th 1978 relating 
freedom of digital information as modified in 2004, the treatment of Personal data 
collected on the Site has been cited in a declaration to the Commission Nationale de 
l’Informatique et des Libertés (pending)  
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You have the right to access, modify, rectify, update or delete your Personal data. To 
exercise one of these rights, you must send a postal letter or e-mail to the Fondation 
Casques Rouges at the following addresses: 
 
Fondation Casques Rouges 
1 rue Descartes 
75005 Paris 
contact@missing.net 
 
indicating your surname, first name(s), address(es). To comply with current regulations, 
the request should be signed and accompanied by a photocopy of proof of identity bearing 
the signature and must state the address to which you wish the reply to be sent. A reply 
will then be sent within two (2) months from receipt of the request. 
 
You may also consult or modify the personal data of your account by visiting the Site and 
by modifying your account settings. 
 
 

5. SECURITY MEASURES FOR PROTECTING YOUR PERSONAL 

DATA  
 

In return for the trust placed in us by the Internet user when he connects to the Site, the 
Casques Rouges are careful to protect the Personal data which they collect.  
 
We have thus set up various security measures to try to ensure that the Personal data you 
supply to us remains confidential and protected against any loss, improper use, 
unauthorised access, disclosure, alteration or destruction. Nevertheless, there is no such 
thing as a perfect or infallible system of security. We are not able to oversee the actions of 
other members with whom you have decided to share your Personal data. We can 
therefore not guarantee that your Personal data will be seen only by authorised persons. 
Nor can we guarantee that the Personal data you share on the Site will not become public. 
We are not in any case responsible for the non-respect of the Charter or of the security 
measures in force on the Site by a third party. You can reduce these risks by using 
commonsense security practices such as creating a difficult password, using different 
passwords and keeping your antivirus software up to date. 
 
 

6. CHECKS 

 
Your attention is drawn to the fact that automatic and generalised checks may be carried 
out to limit malfunctioning, in compliance with the rules in force. 
 
In case of malfunctioning detected by the Site staff or by one or more members, a manual 
check may be carried out to verify any operations performed by one or more users. 
 

7. TRANSFER OF YOUR PERSONAL DATA OUTSIDE THE EU 
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The Personal data which we collect can be transferred and stored outside France and the 
European Union (UE). All the same, we will ensure that these transfers are made to 
countries (i) offering the same level of protection as the applicable European regulations 
or (ii) subject to contracts imposing on all parties a level of protection equivalent to that 
offered by the applicable European regulations.  
 
Your Personal data may also be handled by staff outside the EU who work for us or for one 
of our suppliers.  
 
In any case, by submitting to us your Personal data, you accept this transfer, storage and 
treatment outside the European Union. 
 
All recipients of your Personal data shall be bound by obligations of confidentiality 
guaranteeing a level of security at least equivalent to that offered by European regulations 
on the protection of personal data. 
 

8. PARTIAL NULLITY  
 
If one or more stipulations of the Charter are held to be void by the competent 
jurisdiction, the other clauses shall remain fully effective and valid. 
 

9. MODIFICATION 

 
We are free to modify the Charter at any moment. In case of modification of the Charter, 
the applicable version is that which you accept at the time of your next connection 
following the modification.  
 

10. APPLICABLE LAW AND COMPETENT JURISDICTION  
 
This Charter is governed by and interpreted in accordance with French law. Any litigation or 
objection resulting from or concerning this Charter shall be governed by and submitted to 
French law without taking account of rules of conflicts of law. 
  
In case of litigation relating to the interpretation or execution of this Charter, the Paris 
Tribunals are competent regardless of plurality of defendants or claims under warranty, 
including for summary or motion proceedings. 
 


